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1. Einfuhrung

Ein Tag ist nicht iiberall auf der Erde gleich lang. Die Lange von Tag und Nacht ist
abhingig von Jahreszeit und Standort und variiert umso stérker, je ndher zum Nord- oder
Stidpol sich der Beobachter befindet. Die aktuellen Auf- und Untergangszeiten der Sonne
fiir manche Stédte werden in der jeweiligen Tageszeitung angegeben, doch exakte lokale
Angaben sind oft schwer zu finden. In Dresden geht die Sonne beispielsweise bis zu eine
Stunde frither auf als in Aachen, und auch zwischen Kieler Forde und Bodensee kann der
Unterschied im Sommer mehr als eine halbe Stunde betragen.

SolarView ist ein Programm, das Thnen die genauen Zeiten von Sonnenauf- und
Untergang fiir jeden beliebigen Tag und Ort nennt — ob auf Ihrem Balkon oder an Threm
nichsten Urlaubsort. Dariiber hinaus liefert [hnen SolarView weitere interessante
Informationen iiber die Position der Sonne im Tagesverlauf, beispielsweise ihre Hohe
iiber dem Horizont zur Mittagszeit oder die Dauer zwischen Auf- und Untergang.
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2. Allgemeine Programminformationen

SolarView informiert {iber Auf- und Untergangszeiten der Sonne, ihren Weg durch den
Tageshimmel und die diesbeziiglichen Unterschiede im Jahresverlauf.

Das Programm berechnet die Sonnenbewegung anhand der eingegebenen
Standortkoordinaten und stellt sie in grafischem oder Textformat dar. Die Grafikversion
zeigt die Position der Sonne am Himmel und die Phasen des Tages (Tag, Dammerung,
Nacht) fiir den ausgewéhlten Ort sowie fiir den gesamten Erdball. Die Angaben des
Textfeldes beziehen sich auf den eingegebenen Standort und das gewlinschte Datum. Sie
umfassen die Position der Sonne am Firmament, ihre Hohe zur Mittagszeit, die genauen
Zeiten von Aufgang, Untergang und Hochststand, die Lénge des Tages, den Abstand
zwischen Erde und Sonne sowie den Endzeitpunkt der Abend- und den Beginn der
Morgenddmmerung. Auch die aktuellen Zenitkoordinaten werden angezeigt, d.h. der
Punkt, von dem aus gesehen die Sonne senkrecht iiber dem Beobachter steht.

Mit Hilfe von SolarView konnen Sie den Weg der Sonne und die damit
zusammenhingenden Verdnderungen wihrend der Tageslichtperiode zu jeder Tages- und
Jahreszeit verfolgen. Im Simulationsmodus konnen Sie mit den Pfeiltasten die
Beobachtungszeit d&ndern und den Sonnenstand fiir einen anderen Zeitpunkt abfragen z.B.
eine Stunde spéter, am nichsten Tag, einen Monat oder auch ein halbes Jahr friiher oder
spater. Die Tagesldngen konnen fiir bis zu ein Jahr im Voraus abgefragt werden.

SolarView berechnet die erforderlichen Daten anhand der eingegebenen Koordinaten und
der Uhrzeit. Die Koordinaten kénnen per GPS ermittelt, von Hand eingegeben, auf der
integrierten Weltkarte markiert oder aus der Orientierungspunktdatenbank abgerufen
werden. In der Datenbank kénnen auch manuell in SolarView eingegebene
Positionskoordinaten gespeichert werden.

2.1 Hardware- und Softwareanforderungen

SolarView ist fiir das Betriebssystem Symbian S60/3rd Edition konzipiert. Dariiber
hinaus empfiehlt sich ein eingebauter oder externer GPS-Empfanger zur flexiblen
Koordinatenermittlung. Da SolarView die ihrerseits mit Nokia Maps kompatible
Orientierungspunkt-Datenbank nutzt, gewinnen Sie zusétzliche Vorteile, falls Sie auch
diese beiden Programme in Ihrem Telefon installiert haben. Sie sind jedoch keine
Voraussetzung fiir die Verwendung von SolarView.

SolarView verwendet keine kostenpflichtigen Softwareressourcen. Alle Berechnungen

werden im Telefon durchgefiihrt. Das Programm kann auch ohne SIM-Karte genutzt
werden.
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3. Schlusselbegriffe
3.1. Standortkoordinaten

Beobachtungsstandorte werden in SolarView als Koordinatenpaare (Léngen- und
Breitengrad) angegeben.

Breite

Die Breite liegt zwischen -90° und +90°, wobei die Breitengrade der nordlichen
Hemisphire als positive und die der siidlichen als negative Werte angegeben werden. Die
Breite des Nordpols ist somit +90°, die des Siidpols -90° und die des Aquators 0°. Die
Breitenangabe fiir den Standort des Autors beim Schreiben dieser Zeilen lautet
60°21'50"N, gesprochen 60 Grad, 21 Minuten und 50 Sekunden Nord (+60.3639°). Die
Himmelsrichtungen Nord (N) und Siid (S) sind bei Breitenangaben in Relation zum
Aquator zu verstehen.

Linge

Die Erde ist in 360 Langengrade (Meridiane) von -180° bis +180° unterteilt, wobei die
Erdhaélfte 6stlich des durch Greenwich bei London verlaufenden Nullmeridians mit
positiven Werten bezeichnet wird und westlich davon liegende mit negativen. Die
Breitenangabe fiir den Standort des Autors beim Schreiben dieser Zeilen lautet
25°05'51"0, gesprochen 25 Grad, 5 Minuten und 51 Sekunden Nord (+25,0975°). Die
Himmelsrichtungen Ost (O) und West (W) sind bei Langenangaben in Relation zum
Nullmeridian zu verstehen.

Standortkoordinaten

Durch die kombinierte Angabe von Langen- und Breitengrad kann jeder Ort auf unserem
Planeten genau bezeichnet werden. Der genaue Standort des Autors beim Schreiben
dieser Zeilen war 60°21'50"N, 25°05'51"0 (+60.3639°, +25.0975°).

Koordinatenformat

SolarView gibt Koordinaten im traditionellen Format an, d.h. in Grad, Minuten und
Sekunden (z.B. 25°05'51"0). Falls Sie Koordinaten von Hand eingeben, miissen Sie dies
jedoch im Dezimalformat tun. Dabei ist eine Genauigkeit von bis zu vier Dezimalstellen
moglich. Fiir die Umrechnung gilt, dass ein Grad 60 Minuten entspricht und eine Minute
60 Sekunden.

Beispiel: Umrechnung der Langenangabe 25°05'51" ins Dezimalformat.

Rechnen Sie zuerst die Sekunden in Minuten um: 51 Sekunden sind 51/60 = 0,85
Minuten, so dass der Wert unsers Langengrades 25 Grad plus 5,85 Minuten betragt.
Danach konnen Sie die Minuten in Grad umrechnen: 5,85 Minuten sind 5,85/60 = 0,0975
Grad, womit wir einen Dezimalwert von +25.0975° erhalten. Das Pluszeichen driickt aus,
dass sich der Standort 6stlich vom Nullmeridian befindet.
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Genauigkeit

Die obigen Koordinatenangaben sind auf eine Sekunde genau. Dies entspricht einer
Genauigkeit von 30 Metern, was fiir die Zwecke von SolarView ausreicht.

3.2. Auf- und Untergangszeitpunkt der Sonne

Die Zeitangaben fiir Sonnenauf- und -untergang beziehen sich auf den Moment, in dem
die Sonne vollstindig hinter dem Horizont verschwindet. Hierbei wird von einer
theoretischen Situation ausgegangen, in der sich der Beobachter auf einer Ebene mit dem
Horizont befindet, etwa auf dem Meer. In der Praxis wird der eigentliche Horizont in den
meisten Féllen durch Berge und Hiigel, Baume, Gebaude usw. verdeckt. Zu beachten ist
ferner die durch die Luftschichten der Atmosphére verursachte Brechung des
Sonnenlichts (Refraktion).

3.2.1. Refraktion

Als Refraktion wird die Kriimmung des Lichts in der Atmosphére bezeichnet, welche
Objekte wie die Sonne hdher erscheinen ldsst, als sie es in Wirklichkeit sind. Wie stark
der Effekt ist, hdngt von Lufttemperatur, Luftdruck und Atmosphérenkriimmung ab. Zur
exakten Bestimmung der Refraktion miissen daher die atmosphérischen Bedingungen
entlang der Route bekannt sein, auf der das Licht den Beobachter erreicht.

SolarView kalkuliert die Auf- und Untergangszeiten mit Hilfe des iiblicherweise
verwendeten Refraktionswerts von 34 Bogenminuten (34'). Da diese sog.
Horizontalrefraktion etwas groBer ist als der wahrgenommene Sonnendurchmesser (32"),
sieht es so aus, als wiirde die Sonne eben erst den Horizont tangieren, wenn sie eigentlich
bereits hinter ihm verschwunden ist

3.3. Die Position der Sonne am Himmel

3.3.1. Die Hohe der Sonne

SolarView gibt die Hohe der Sonne {iber dem Horizont mit der Genauigkeit von einem
Hundertstel Grad an. Die Sonne kann zu diesem Zeitpunkt noch knapp iiber dem
Horizont zu sehen sein.

3.3.2. Sonnenrichtung oder Azimut

Die Richtung der Sonne, in der astronomischen Fachsprache als Azimut
bezeichnet wird von SolarView als Winkel (im Uhrzeigersinn) zur Nordrichtung
angegeben. Die Genauigkeit betrdgt ein Hundertstel Grad. Das Azimut liegt
zwischen 0° und 360°, beispielsweise betrigt es 180°, wenn die Sonne genau im
Stiden steht.
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3.3. Mittag

In der Alltagssprache wird die Zeit 12:00 Uhr als Mittag bezeichnet. Fiir SolarView ist
Mittag der Zeitpunkt, zu dem die Sonne am hdchsten tiber dem Horizont steht. Dies ist
meist nicht genau um zwolf Uhr der Fall.

Beispielsweise erreicht die Sonne in Deutschlands normaler Zeitzone (d.h. MEZ ohne
Sommerzeit) nur entlang des 15. Langengrads, der durch Gorlitz an der Neif3e verlauft,
ihren Hochststand um 12:00 Uhr. In Diisseldorf ist der eigentliche Mittag erst 39 Minuten
spéter.

SolarView verwendet exakte Koordinaten und zeigt anhand dieser die tatsachliche
Mittagszeit sowie den hochsten Stand der Sonne {iber dem Horizont.

3.4. Morgen- und Abendddmmerung

Die Ddmmerungsangaben von SolarView beziehen sich auf die sog. biirgerliche
Dammerung, wahrend der die Sonne 0-6° unter dem Horizont steht.

In der Astronomie werden mehrere Ddmmerungsabstufungen verwendet.

Biirgerliche Ddmmerung: Die Sonne steht 0-6° unter dem Horizont und die hellsten
Sterne und Planeten (z.B. die Venus) sind erkennbar. Der Begriff stammt aus dem
Mittelalter und bezeichnete die Zeitspanne, zu der die Biirger nach Sonnenuntergang
noch ohne Kerzenlicht ihre Arbeiten verrichten konnten.

Nautische Didmmerung: Die Sonne steht 6-12° unter dem Horizont. Der Begriff
bezeichnete in der Vergangenheit die Zeitspanne, in der Seefahrer den Horizont noch
erkennen, aber bereits mit Hilfe der Sterne navigieren konnten.

Astronomische Didmmerung: Die Sonne steht 12-18° unter dem Horizont, wobei am
Horizont noch ein Lichtschimmer erkennbar ist, astronomische Beobachtungen jedoch
bereits moglich sind.

Dunkelheit: Die Sonne steht mehr als 18° unter dem Horizont.

3.5. Uhrzeit

SolarView verwendet bei den Berechnungen die Zeiteinstellungen des Telefons, und die
angegebenen Ergebnisse basieren auf diesen.

Um korrekte Angaben zu erhalten, miissen Sie sicherstellen, dass sowohl die Uhrzeit als
auch die Zeitzone richtig eingestellt sind. Denken Sie hieran insbesondere, falls Sie
Koordinaten fiir unterschiedliche Zeitzonen eingeben. Falls in Threm Telefon
beispielsweise die deutsche Zeitzone MEZ (UTC+1) eingestellt ist und Sie die
Koordinaten eines Ortes in England (Zeitzone UTC+0) eingeben, nennt das Programm
fiir Sonnenaufgang, -untergang und Dammerung die deutschen Zeiten.
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4. Anwendungsmodi

4.1. Echtzeitmodus

In SolarView konnen Sie zwischen zwei Modi wechseln: Echtzeit und Simulation. Im
Echtzeitmodus verwendet das Programm die zuletzt eingegebenen Standortkoordinaten
und die Uhrzeit des Telefons. Die Angaben auf dem Bildschirm werden alle 30 Sekunden

aktualisiert.

SolarView

Ornenposition

Optionen

Abb. 1 Sonnenpositionsansicht im Echtzeitmodus.

Im Simulationsmodus koénnen Sie Informationen fiir einen zukiinftigen oder bereits
vergangenen Zeitpunkt ermitteln. Dies ginge theoretisch auch durch Andern der
Telefonzeiteinstellungen mit nachfolgendem Neustart von SolarView, was jedoch
umstédndlich und zeitraubend wire.

4.5. Simulationsmodus

Im Simulationsmodus konnen Sie die Beobachtungszeit mit den Pfeiltasten dndern. Dies
funktioniert in allen Ansichtsfenstern mit Ausnahme der Ubersicht, wo die Pfeiltasten zur
Listennavigation dienen.

Im Simulationsmodus haben Sie die Wahl zwischen den Untermodi Minuten & Stunden
und Tage & Monate. Wiéhlen Sie dazu Optionen>Simulation>Minuten & Stunden
bzw. Optionen>Simulation>Tage & Monate.
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Im Untermodus Minuten & Stunden konnen die Zeit in Minuten- oder Stundenschritten
dndern, in Tage & Monate entsprechend in Tages- oder Monatsintervallen. Auf diese
Weise gelangen Sie schnell zum gewiinschten Beobachtungszeitpunkt (Jahr, Tag,
Uhrzeit). Mit Links- und Rechtspfeil dndern Sie die kleinere Einheit des jeweiligen
Untermodus (Minute bzw. Tag), mit Auf- und Abwértspfeil die grofere (Stunde bzw.
Tag).

2

1 ao 2 KBC DEF 3

4 GHI 5 oKL Mno 6
Trars Bruw wWxyz9

\*a 0_« f.-.iu.j.

Abb.2 Bei diesem Modell ersetzt die Navigationstaste (im roten Kreis) die Pfeiltasten.

Wenn der Simulationsmodus aktiviert ist, erscheint die Zeitangabe in rot, gefolgt von
dem Buchstaben "S" in Klammern.

solarView

Sonnenposition

Optionen

Abb. 3 Sonnenpositionsansicht im Simulationsmodus.
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5. Die Ansichten des Programms
5.1. Startansicht

In der Startansicht sehen Sie das Hintergrundbild und darunter ein Textfeld mit den
zuletzt eingegebenen Koordinaten, den Zeiten von Sonnenauf- und -untergang sowie
Datum und Uhrzeit.

SolarView

Startansicht
AE e

Abb. 4 Startansicht

5.2. Sonnenpositionsansicht

In der Sonnenpositionsansicht wird die Position der Sonne am Himmel grafisch
dargestellt, wobei der Himmel in blau erscheint und die Sonne als gelber Kreis. Die
vertikalen gestrichelten Linien markieren die Haupthimmelsrichtungen.

Das Textfeld am unteren Bildschirmrand zeigt die aktuelle Hohe und das Azimut
der Sonne, ihre Hohe zur Mittagszeit (Zeitangabe in Klammern), Sonnenauf- und
-untergangszeit sowie den Beobachtungszeitpunkt.

Die Bildschirmbreite entspricht 360°, um die Position der Sonne rund um die Uhr
darstellen zu kénnen. Die Bildschirmhdhe entspricht 90°. Das Azimut wird in
SolarView als Winkel zur Nordrichtung angegeben (im Uhrzeigersinn), so dass die
Himmelsrichtungen den folgenden Winkeln entsprechen:

Norden: 0°
Nordost: 45°
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Osten: 90°
Siidost: 135°
Siiden: 180°
Siidwest: 225°
Westen: 270°
Nordwest: 315°

Die Hohe der Sonne wird in SolarView als Winkel (zwischen -90° und +90°) zum
Horizont angegeben. Eine negative Hohenangabe besagt, dass die Sonne unter dem
Horizont steht.

Fiir Standorte in der nordlichen Hemisphédre markieren die vertikalen Strichlinien die
Haupthimmelsrichtungen Osten, Siiden und Westen, in der siidlichen dagegen Westen,
Norden und Osten. Die Grenze zwischen den Hemisphédren verlauft genau genommen
nicht am Aquator, sondern entlang der Breite, von der aus gesehen die Sonne im Zenith
steht, d.h. senkrecht iiber dem Betrachter. Sie variiert im Jahresverlauf zwischen den
Wendekreisen von Krebs und Steinbock.

Die Himmelsrichtungen sind am oberen Ende der Strichlinien angegeben: entweder
Osten (0), Siiden (S) und Westen (W) oder Westen (W), Norden (N) und Osten (O).

SolarView
Sonnenposition

SolarView

Sonnenposition

e 19

Optionen SchliefenjOptionen

Abb. 5a und 5b Sonnenpositionsansicht zum selben Beobachtungszeitpunkt in der
nordlichen und siidlichen Hemisphére. Die gewihlten Standorte befinden sich in
Finnland (60°21'50"N 25°05'51"E) und Namibia (17°58'44"S, 12°02'34"E). Die
Zeitangabe beider Bildschirmansichten bezieht sich auf Finnland (UTC+2), in Namibia
war es zu diesem Zeitpunkt 10:25:11 Uhr.

Zum Entstehungszeitpunkt dieses Abschnittes, am 6.0ktober 2008 um 14:29:53 Uhr,
stand die Sonne vom Garten des Verfassers (60°21'50"N 25°05'51"E) aus gesehen
+22.32° iiber dem Horizont in slidsiidwestlicher Richtung: das Azimut betrug 202.21°.
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GroBendarstellung der Sonne

Um das Ablesen zu vereinfachen, ist die Sonnenscheibe auf dem Bildschirm
iiberdimensional dargestellt. Ihr Durchmesser am Himmel entspricht 32 Bogenminuten.
In SolarView nimmt die Darstellung dagegen 12 Pixel, was bei einem 240 Pixel breiten
Bildschirm einem Durchmesser von 18° entspricht, also mehr als dem 33-fachen des
OriginalmalBstabs.

Simulationsmodus

Im Simulationsmodus kénnen Sie die Beobachtungszeit &ndern und Sonnenpositionen
kiinftiger oder vergangener Zeitpunkte betrachten.

SolarView

SONnenpo

SchlieBenjOptionen SchlieBenjOptionen

Abb. 6a, 6b und 6¢ Drei unterschiedliche Sonnenpositionen am selben Tag, vom
Standort 60°21'50"N, 25°05’51"”0 aus betrachtet.

5.3. Tag- & Nachtansicht

Die Tag- & Nachtansicht stellt die Phasen eines Tages grafisch dar: Tag (gelb),
Dammerung (dunkelgrau) und Nacht (schwarz). Als Tag wird in diesem Zusammenhang
die Zeitspanne zwischen Sonnenauf- und -untergang bezeichnet. In der
Dammerungsphase steht die Sonne 0-6° unter dem Horizont und wahrend der Nacht
mehr als 6°.

Das Textfeld am unteren Bildschirmrand zeigt die Zeiten von Sonnenauf- und
-untergang, die Lange des Tages, die Mittagszeit und den Beobachtungszeitpunkt.
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Simulationsmodus

Im Simulationsmodus sehen Sie, wie sich die Tagesldnge im Jahresverlauf é@ndert.

SolarView SolarView

Tla I;] 'E\: H diC ht i} El T'a I;] 'E\: H diC ht

18:00 06:00

12:00

0:27, Uritergandg: 16:15

SchliefenjOptionen

Abb. 7a und 7b Tag- und Nachtanzeige fiir Ende Juni und Ende Dezember am Standort
60°21'50"N, 25°05'51"0.

5.4. Globusansicht

In der Globusansicht sehen Sie, wo auf der Erde gerade Tag ist, d.h. die Sonne liber dem
Horizont steht, wo es ddimmert (Sonne 0-6° unter dem Horizont) und wo es Nacht ist
(Sonne mehr als 6° unter dem Horizont). Der Nachtbereich erscheint in schwarz, die
Déammerungszone schattiert und der Tageslichtbereich in hellen Farben. Die Sonne ist
dort eingezeichnet, wo sie gerade im Zenit steht, d.h. sich genau senkrecht iiber dem
Beobachter befiande. Die zuletzt eingegebene Beobachtungsposition ist mit einem roten
Kreis markiert.

Das Textfeld am unteren Bildschirmrand zeigt die Zenitkoordinaten der Sonne und den
Beobachtungszeitpunkt.
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Simulationsmodus

Im Simulationsmodus sehen Sie, welche Teile der Erde zu verschiedenen Jahres- und
Tageszeiten von der Sonne beschienen werden.

SolarView SolarView

Globus ¥ El Globus

Ienit: 43"N 6345510

Optionen SchliefenjOptionen
Abb. 8a und 8b Globusansicht im Juni und im Dezember.

5.5. Ubersicht

Die Ubersicht listet alle von SolarView generierten Informationen im Textformat auf. Die
kleinen Textfelder unter den Grafiken enthalten jeweils nur die wichtigsten Daten, um
mehr Platz fiir die Grafik zu lassen

Die Ubersicht enthilt folgende Informationen:

o Zeit
Beobachtungszeit
¢ Standort

zuletzt eingegebene Positionskoordinaten
e Hohe, Azimut
Hohe und Azimut der Sonne
e Hohe zur Mittagszeit:
Hochststand der Sonne wihrend des Tages
* Mittag
Zeitpunkt, zu dem die Sonne ihren Hochststand erreicht
* Aufgang, Untergang
Auf- und Untergangszeitpunkt der Sonne
* Tagesldnge
Zeitraum zwischen Sonnenauf- und -untergang
¢ Ende der Abendddammerung
Endzeitpunkt der Abendddmmerung, Beginn der Nacht
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e Beginn der Morgenddmmerung
Anfangszeitpunkt der Morgenddmmerung, Ende der Nacht
e Zenit

Koordinaten des Standorts, von dem aus gesehen sich die Sonne senkrecht {iber

dem Beobachter befindet
e Abstand zur Sonne
Abstand zwischen Erde und Sonne zum Beobachtungszeitpunkt

solarview solarView
Ubersicht Ubersicht

Zeit Mittag

12.06.2009 11:46:45 13:20

Standort

Untergang
0z 247

Aufgang,

60°21'50"N 25°05'51"0

Héhe, Azimut

Tagesldnge
+409,45° 146 %

1€

Ende der Abenddammer...

Hdéhe zur Mittagszeit
o 00:34

+52,81°

solarView
Ubersicht

Ende der Abenddammer...
00:34

SchliefenjOptionen Schliefen

Beginn der Morgendam...

23°10'07"N 48

Abstand zur Sonne
151.916.100 km

Optionen

Abb. 9a, 9b und 9¢ Ubersicht
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6. Verwendung des Programms

6.1. Start

Wenn Sie das Programm starten, 6ffnet sich ein Menii, das Sie als erstes nach den
Koordinaten Ihres Standorts fragt. Diese konnen von Hand eingegeben, per GPS
ermittelt, aus der Orientierungspunktdatenbank abgerufen oder auf der integrierten
Weltkarte markiert werden. Falls Sie keine Koordinaten eingeben oder Abbruch driicken,
verwendet SolarView die Standardkoordinaten. Der bei der Programmauslieferung
eingestellte Standardwert ist 60°21'50"N, 25°05'51"0.

SolarView

Position eingeben

Manuell

Uber GPS
Orientierungspunkt-Da...
Von Karte

0K Abbruch

Abb. 10 Startmenii des Programms

Nach Eingabe der Beobachtungsposition 6ffnet sich die Startansicht, von der aus Sie iiber
das Menii oder durch Driicken der Zifferntasten 4 und 6 zu den weiteren Ansichten
gelangen.

6.1.1. Standardkoordinaten andern

Die beim Start eingegebene oder iibernommene Ortsangabe liefert die
Standardkoordinaten fiir die Anwendung. Hierfiir bietet sich beispielsweise Thre
Heimatadresse an. Um Ihre personlichen Standardkoordinaten zu definieren, geben Sie
diese ein wie in Abschnitt 6.3 (siehe unten) beschrieben und wihlen Sie dann
Menii>Einstellungen>Solar View>Optionen>Positionskoordinaten>Als Standard
festlegen.
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6.2. Meniistruktur

Die folgenden Bildschirmansichten illustrieren die Meniistruktur von SolarView.

Position eingeben Positionskoordinaten *

Simulation 4
Ansicht drehen
Hilfe
Infos
' Beenden

Ansicht auswahlen
Positionskoordinaten
Simulation

Ansicht drehen

Hilfe

Wadhlen Abbruchjwadhlen

Abb. 11a und 11b Hauptmenii

'—E
Po|' Manuell
An Uber GPS

Po. Orientierungspunkt-Da...

. | Von Kart
SIE on karte

Ansicht drehen
Hilfe

Wadhlen

Abb. 12 Untermenii Position eingeben
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) Solarview

" Ansick’ Sonnenposition
Posititc Tag & Nacht
Globus
Ubersicht
Startansicht

Simul:
Ansich
Hilfe

Wahlen

Abb. 13 Unterment Ansicht auswdhlen
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Position eingeben Position eingeben
Ansicht auswahlen _ | Ansicht auswéhlen

| PDSitiDﬂSkDO[;r-SpEi[hErI'I " Po Speichern

Simulation Sjr Als Standard festlegen

Ansicht drehen Ansicht drehen
Hilfe Hilfe

Wahlen

Position eingeben
~Ansicht auswahlen
| Po'mhern

Sjr Bearbeiten

pp Loschen
il Als Standard festlegen

Wadhlen Abbruch

Abb. 14a, 14b und 14¢ Untermenii Positionskoordinaten. Bitte beachten Sie, dass die
Befehle zum Bearbeiten und Loschen nur in dem Fall angezeigt werden, dass die
Koordinaten aus der Orientierungspunkt-Datenbank geladen wurden. Der Befehl Als
Standard festlegen ist sichtbar, wenn Sie wihrend der Nutzung des Programms andere
Koordinaten verwenden als die standardmafigen.
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SolarView

Position eingeben »
Ansicht auswahlen »
Positionskoordinaten  *
"sin Aus -
Anl  Minuten & Stunden

Hil Tage & Monate

Wadhlen

Abb. 15 Untermeni Simulation

6.3. Eingabe der Positionskoordinaten

6.3.1. Manuell

Sie konnen die Koordinaten des gewiinschten Beobachtungsstandorts direkt tiber die
Tastatur eingeben. Verwenden Sie dazu das oben beschriebene Dezimalformat (max. vier
Dezimalstellen).

SolarView

Linge
25,0975

Standort:
Aufgang: 0

Abb. 16 Manuelle Eingabe der Positionskoordinaten
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6.3.2. GPS

Mit Hilfe eines GPS-Empfangers konnen Sie ihre exakte geographische Position
ermitteln. Viele Telefonmodelle sind mit GPS-Empfangern ausgestattet oder konnen iiber

Bluetooth mit solchen kommunizieren.

Falls Sie ein GPS-Gerit verwenden, konnen Sie in SolarView iiber Optionen>Position

eingeben>Uber GPS eine Satellitenverbindung aufbauen, um Ihren Standort zu ermitteln.
Nach dem erfolgreichen Verbindungsaufbau erscheinen die Koordinaten auf dem
Bildschirm und kénnen mit OK {ibernommen oder mit 4bbruch abgelehnt werden.

Falls innerhalb eines Zeitraums von drei Minuten keine ausreichende
Satellitenverbindung hergestellt werden kann, erscheint eine Fehlermeldung. Wechseln
Sie in diesem Fall zuriick zur vorherigen Ansicht.

@ SolarView
GPS-Empfanger

Koordinaten werden

definiert...
r""‘_"‘_ﬁ"_’m

Abbruchj 0K

O SolarView
GPS-Empfanger
ot il SIS

Breite
650°21'51"N

Lange

AFETEE

Abb. 17a und 17b Positionsermittlung mit Hilfe eines GPS-Empféngers.
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solarView Solarview
GPS-Empfanger GPS-Empfanger

LBS-Fehler! LBS-Fehler!
Position nicht auffindbar [eitliberschreitung

Abb. 18a und 18b GPS-Fehlermeldungen: 18a) GPS-Empfianger nicht gefunden. 18b)
Standortkoordinaten nicht innerhalb von drei Minuten gefunden.
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6.3.3. Orientierungspunkt-Datenbank

Falls in Threm Telefon die Orientierungspunkt-Datenbank installiert ist (eine begleitende
Komponente des Betriebssystems Symbian S60), kann SolarView auch die dort
gespeicherten Koordinaten nutzen. Um neue Koordinaten in der Datenbank zu speichern,
konnen Sie diese separat starten oder direkt von SolarView aus aufrufen.

Falls Sie das separate Programm Orientierungspunkte verwenden, kdnnen Sie {iber Nokia
Maps exakte Koordinaten auswéhlen und in der Datenbank speichern. Beim Zugriff auf
die Datenbank iiber SolarView koénnen Sie die zu speichernden Koordinaten allerdings
nicht in Nokia Maps auswéhlen, sondern nur in SolarView selbst. Ndhere Informationen
zur Orientierungspunkt-Datenbank und zu Nokia Maps finden Sie in der
Bedienungsanleitung des Telefons und auf der Nokia-Webseite.

6.3.4. Weltkarte

SolarView enthalt eine Weltkarte, auf der Sie mit Hilfe der Pfeiltasten (siche Abb. 1) den
gewiinschten Ort auswéhlen kdnnen. Der Auswahlcursor erscheint als roter Kreis. Die
maximale Auflosung der Kartenansicht ist knapp 11 Bogenminuten (11'), was etwa 20
km auf der Erde entspricht. Falls Sie eine genauere Ortsbestimmung bendtigen, sollten
Sie eine der weiter oben beschriebenen Methoden nutzen.

Auf der Karte sind Nullmeridian und Aquator als durchgehende weife Linien markiert.
Die Wendekreise von Krebs und Steinbock und der nérdliche und siidliche Polarkreis
erscheinen als gestrichelten Linien.

Zoomfunktion

Wenn Sie die SolarView-Karte 6ffnen, ist sie so klein, dass sie komplett auf den
Bildschirm passt. Driicken Sie zum VergroBern der Ansicht die Sterntaste (*) und zum
Verkleinern die Raute (#).

Gro6Bere Strecken lassen sich am besten bei stark verkleinerter Ansicht tiberbriicken.

Wenn Sie nahe am gewiinschten Ort sind, vergrofern Sie die Ansicht zur genauen
Lokalisierung.
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solarview solarView
Weltkarte ' Weltkarte

2 asc  DEF 3
S kL | HND 6
Sruv  wWxyz9
0_w 38

Abb. 20 Die rot markierten Tasten dienen zum VergroBern (*) und Verkleinern (#) der
Ansicht.

6.4. Koordinatenangaben speichern, bearbeiten und I6schen

Um Ihre per GPS ermittelten, von Hand eingegebenen oder auf der Karte ausgewéhlten
Koordinaten in der Orientierungspunkt-Datenbank zu speichern, wéhlen Sie
Optionen>Positionskoordinaten>Speichern.

Um aus der Datenbank aufgerufene Koordinaten zu modifizieren, 6ffnen Sie das
Bearbeitungsfenster des Orientierungspunktprogramms mit
Optionen>Positionskoordinaten>Bearbeiten. Um Koordinaten aus der Datenbank zu
16schen, wihlen Sie Optionen>Positionskoordinaten>Loschen und bestdtigen Sie den
Loschvorgang.
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6.5. Navigation zwischen den Ansichten

Zwischen den einzelnen Ansichten konnen Sie iiber das Menii oder die Tastatur
wechseln. Bei der Tastaturnavigation gelangen Sie mit der Taste 6 zur nichsten Ansicht
und mit 4 zur vorherigen. Dies ist sowohl im Echtzeit- als auch im Simulationsmodus
moglich.

Die Ansichten erscheinen in dieser Reihenfolge:

Startansicht — Sonnenpositionsansicht — Tag- & Nachtansicht — Globusansicht —
Ubersicht.

2 ABC DEF 3

5 kL | HnD 6

81wy wWxyz9

O_ @ o3#

Abb. 21 Mit den rot markierten Tasten 4 und 6 wechseln Sie zur vorigen bzw. néchsten
Ansicht.
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6.6. Ausrichtung

Sie konnen die Darstellung um 90° drehen, um sie im Querformat zu betrachten.

Q Solarview
Sonnenposition

Optionen

3 SolarView

Sonnenposition

Abb. 21a und 21b Die Sonnenpositionsansicht im Hoch- und im Querformat.
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6.7. Ansichtsspezifische Hilfe

Die integrierte Hilfedatei kann {iber das Menii gedffnet werden. Sie ist ansichtsbasiert,
d.h. Sie erhalten sofort die Informationen zu der Ansicht, von der aus Sie die Hilfe
aufrufen

Vr Tag- & Machtansicht
. 5/6

Installationen/Programme =
SolarView = Optionen =
Ansicht wahlen = Tag & Nacht

Der 24-Stunden-Kreis i
diese in unterschiedlichen

Favlmm mrliaime= £ i Bl

Optionen Schlieien

Abb. 22 Hilfetext zur Tag-& Nachtansicht.

6.8. Kundendienst und Feedback

Unser englischsprachiger Kundendienst hilft [hnen jederzeit gerne weiter. Bitte senden
Sie Thre Fragen, Anmerkungen und Vorschlidge in englischer Sprache an die folgende
Adresse:

solarview.support@arsoftware.fi
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